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Zakres materiału
• Tło historyczne
• Wprowadzenie do obsługi AVR IDE

WinAVR, AVR Studio, MegaLoad
• Przypomnienie podstaw układów cyfrowych

Technologia, bramki, wyjścia trójstanowe, przerzutniki...

• Mikroprocesor
Budowa mikroprocesora, szyny, kod maszynowy, asembler...

• Pamięci
RAM i ROM, Dynamiczne i statyczne, dekodowanie adresu

• Mikroprocesor-pamięć-układy we/wy
Zasady transmisji danych między układami

• Reprezentacja danych w systemie binarnym
Liczby całkowite, zmiennoprzecinkowe, znaki alfanumeryczne, grafika

• Programowanie
Algorytm, języki programowania, kompilacja, konsolidacja, debugging

• Programowalne układy scalone
• Przykłady układów mikroprocesorowych

Źródła informacji
• This lecture: http://www.eletel.p.lodz.pl/~pms/dyda_pl.html
• H. Feichtinger, Mikrokomputery – poradnik, WKŁ
• P. Misiurewicz, Podstawy techniki mikroprocesorowej, WNT
• R. Baranowski, Mikrokontrolery AVR ATmega w praktyce, BTC
• J. Doliński, Mikrokontrolery AVR w praktyce, BTC
• T. Łuba, K. Jasiński, B. Zbierzchowski,

Specjalizowane układy cyfrowe w strukturach PLD i FPGA, WKŁ
• Standardowe cyfrowe układy scalone

– http://www.standardics.philips.com/products/
• AT Mega:

– http://www.atmel.com/
– http://www.avrfreaks.net/
– http://sourceforge.net/projects/winavr/
– http://www.microsyl.com/megaload/megaload.html

• Układy programowalne
– http://www.altera.com/html/literature/
– http://www.latticesemi.com/products/
– http://www.xilinx.com/partinfo/databook.htm
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Tło historyczne

Kamienie milowe rozwoju
technik obliczeniowych

• Liczydło - wynalezione w Babilonie około 5000 lat temu
• Arytmometr mechaniczny - wynaleziony niezależnie przez

Wilhema Schnickarda w 1623 i Blaisea Pascala w 1652
• System binarny - podstawy teoretyczne opracowane przez

Gottfrieda Wilhelma Leibnitza w 1674
• Tabulator -  urządzenie do zapisu danych na kartach perforowanych wynalezione

przez Hermana Holleritha w 1880, wykorzystane podczas spisu ludności w USA
• Komputer Alana Turinga - abstrakcyjny model komputera
• Komputer elektromechaniczny (przekaźnikowy) - 1935, Conrad Zuse

Liczydło rzymskie i rosyjskie tabulator

arytmometr

Źródło ilustracji: Wikipedia
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Generacje komputerów

III generacja komputerów
• W końcu lat 60. opracowano pierwsze układy scalone zawierające nieliczne bramki

logiczne. Komputery zbudowane z takich układów zaliczane są do trzeciej
generacji.

IV generacja komputerów
• W budowie komputerów wykorzystano układy scalone wielkiej skali integracji

(Very Large Scale of Integration - VLSI).

I generacja komputerów
• Eniac - komputer składający się z 1800

lamp elektronowych, zbudowany w 1946
przez na potrzeby Armii USA (zajmował
150m3, zużywał 50kW energii, wykonywał
około 10000 prostych operacji
arytmetycznych na sekundę)

II generacja komputerów
• W 1956 w MIT zaprojektowano i wykonano

pierwszy komputer tranzystorowy

Źródło ilustracji: Wikipedia

Pamięci
Mechaniczne - np. karty perforowane
Elektromechaniczne - przekaźnikowe
Ferrytowe
Na rurach rtęciowych
Drutowe
Bębnowe
...

Półprzewodnikowe

Źródło ilustracji: Wikipedia

pamięć bębnowa

pamięć ferrytowa

pamięć
półprzewodnikowa
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Mikro...
Procesor

układ elektroniczny wykonujący obliczenia według
modyfikowalnego programu

Mikroprocesor
procesor upakowany w pojedynczym układzie
scalonym

Mikrokomputer
komputer zawierający mikroprocesor

Mikroprocesory
Mikroprocesor
• 4-bitowy - 1970, TMS1000 firmy Texas Instruments
• 8-bitowy - Intel 8008 w 1972, Intel 8080 w 1974, Motorola 6800 ...
• 16-bitowy... 32-bitowy... 64-bitowy...
• ...

Źródło ilustracji: Wikipedia

Komputer osobisty
Komputer osobisty - Personal computer

Stosunkowo tani (<$1000),
zaprojektowany do użytku
domowego lub biurowego

• Mark 8 (do samodzielnego montażu)
1974,

• Altair (do samodzielnego montażu),
400$, Intel 8080, 1975,

• Apple, 900$, procesor Motorola
6502, 1976,

• IBM PC, 1981,
• Apple, MacIntosh, 1983,
• ...
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Podstawowe układy logiczne
przypomnienie

Bramki logiczne

Inwerter

Bufor  Inwerter

AND  NAND

OR  NOR

EXOR

?

?

?

Zadanie: Połącz tablice i układ po prawej stronie z
odpowiadającymi im bramkami po lewej
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Bramki logiczne
Technologia

TTL - NAND
CMOS - NANDCMOS - Inwerter

1

1

0

1

10

Bramki logiczne
Wielowejściowe bramki logiczne
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Funkcje logiczne
Układ

( ) ( )( ) ( )( )( )cbbabacbbacbF •++•++•++••=

c

b
a

F

F=~(((b&c)&(~((~(a|b))|(b&c))))  |  ~~((~~(a|b))&~(~(a|b)|(b&c))))

Funkcja logiczna

Tablica Karnaugh

b
a

Układ i funkcja po uproszczeniu

F=~(a|b)

baF +=

Multipleksery

Dwa 4.wejściowe multipleksery 
z 2. wspólnymi wejściami adresującymi

74f153 - http://www.standardics.philips.com/products/

I3 I2 I1 I0
S1
S0

Y

1 0
a
b

Y

c
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Bramki logiczne
Łączenie wejść i wyjściem

• Sprawdź na stronie producenta
parametry typowych cyfrowych
układów scalonych CMOS:

– częstotliwości pracy
– opóźnienia sygnału
– impedancje wejściową bramki
– impedancję wyjściową zwykłej

bramki
– impedancję wyjścia bramki

trójstanowej w czasie gdy jest
ona odłączona

Wyjście      Wejście

Bramki logiczne
Łączenie wyjść bramek

0 1
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Bramki logiczne
Wyjścia trójstanowe

Przerzutniki

RS

D

Źródło schematu:
http://www.standardics.philips.com/products/

JK • Jak działa przerzutnik JK?
• Co to są układy synchroniczne?
• Czy pokazane tu przerzutniki D i JK są

układami synchronicznymi?
• Na czym polega działanie przerzutnika

w układzie Master-Slave?
• Czy pokazany na schemacie

przerzutnik D działa w układzie Maser-
Slave?
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Wprowadzenie do obsługi
AVR IDE

WinAVR + AVR Studio + MegaLoad

WinAVR

C:\WinAVR\bin

C:\WinAVR\avr\bin

C:\WinAVR\utils\bin

Pulpit
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WinAVR: Nowy projekt

1. Uruchom Programmers Notepad (PN)
2. Wybierz File->NewProject
3. Utwórz nowy folder dla projektu
4. Utwórz nowy plik projektu
5. Utwórz nowy plik w języku C
6. Zapisz pliki do foldera projektu
7. Uruchom MFile
8. Ustaw podstawową nazwę pliku
9. Ustaw jednostkę ATMega 128
10. Wyłącz optymalizację (ustawić na 0)
11. Ustaw typ danych wyjściowych

na Extended COFF
11. Zapisz makefile do foldera projektu
12. Dodaj pliki do projektu (w PN)

1. Uruchom Programmers Notepad (PN)
2. Wybierz File->NewProject
3. Utwórz nowy folder dla projektu
4. Utwórz nowy plik projektu
5. Utwórz nowy plik w języku C
6. Zapisz pliki do foldera projektu
7. Uruchom MFile
8. Ustaw podstawową nazwę pliku
9. Ustaw jednostkę ATMega 128
10. Wyłącz optymalizację (ustawić na 0)
11. Ustaw typ danych wyjściowych

na Extended COFF
11. Zapisz makefile do foldera projektu
12. Dodaj pliki do projektu (w PN)

WinAVR: Nowy projekt



13

1. Uruchom Programmers Notepad (PN)
2. Wybierz File->NewProject
3. Utwórz nowy folder dla projektu
4. Utwórz nowy plik projektu
5. Utwórz nowy plik w języku C
6. Zapisz pliki do foldera projektu
7. Uruchom MFile
8. Ustaw podstawową nazwę pliku
9. Ustaw jednostkę ATMega 128
10. Wyłącz optymalizację (ustawić na 0)
11. Ustaw typ danych wyjściowych

na Extended COFF
11. Zapisz makefile do foldera projektu
12. Dodaj pliki do projektu (w PN)

WinAVR: Nowy projekt

1. Uruchom Programmers Notepad (PN)
2. Wybierz File->NewProject
3. Utwórz nowy folder dla projektu
4. Utwórz nowy plik projektu
5. Utwórz nowy plik w języku C
6. Zapisz pliki do foldera projektu
7. Uruchom MFile
8. Ustaw podstawową nazwę pliku
9. Ustaw jednostkę ATMega 128
10. Wyłącz optymalizację (ustawić na 0)
11. Ustaw typ danych wyjściowych

na Extended COFF
11. Zapisz makefile do foldera projektu
12. Dodaj pliki do projektu (w PN)

WinAVR: Nowy projekt



14

1. Uruchom Programmers Notepad (PN)
2. Wybierz File->NewProject
3. Utwórz nowy folder dla projektu
4. Utwórz nowy plik projektu
5. Utwórz nowy plik w języku C
6. Zapisz pliki do foldera projektu
7. Uruchom MFile
8. Ustaw podstawową nazwę pliku
9. Ustaw jednostkę ATMega 128
10. Wyłącz optymalizację (ustawić na 0)
11. Ustaw typ danych wyjściowych

na Extended COFF
11. Zapisz makefile do foldera projektu
12. Dodaj pliki do projektu (w PN)

WinAVR: Nowy projekt

1. Uruchom Programmers Notepad (PN)
2. Wybierz File->NewProject
3. Utwórz nowy folder dla projektu
4. Utwórz nowy plik projektu
5. Utwórz nowy plik w języku C
6. Zapisz pliki do foldera projektu
7. Uruchom MFile
8. Ustaw podstawową nazwę pliku
9. Ustaw jednostkę ATMega 128
10. Wyłącz optymalizację (ustawić na 0)
11. Ustaw typ danych wyjściowych

na Extended COFF
11. Zapisz makefile do foldera projektu
12. Dodaj pliki do projektu (w PN)

WinAVR: Nowy projekt



15

1. Uruchom Programmers Notepad (PN)
2. Wybierz File->NewProject
3. Utwórz nowy folder dla projektu
4. Utwórz nowy plik projektu
5. Utwórz nowy plik w języku C
6. Zapisz pliki do foldera projektu
7. Uruchom MFile
8. Ustaw podstawową nazwę pliku
9. Ustaw jednostkę ATMega 128
10. Wyłącz optymalizację (ustawić na 0)
11. Ustaw typ danych wyjściowych

na Extended COFF
11. Zapisz makefile do foldera projektu
12. Dodaj pliki do projektu (w PN)

WinAVR: Nowy projekt

1. Uruchom Programmers Notepad (PN)
2. Wybierz File->NewProject
3. Utwórz nowy folder dla projektu
4. Utwórz nowy plik projektu
5. Utwórz nowy plik w języku C
6. Zapisz pliki do foldera projektu
7. Uruchom MFile
8. Ustaw podstawową nazwę pliku
9. Ustaw jednostkę ATMega 128
10. Wyłącz optymalizację (ustawić na 0)
11. Ustaw typ danych wyjściowych

na Extended COFF
11. Zapisz makefile do foldera projektu
12. Dodaj pliki do projektu (w PN)

WinAVR: Nowy projekt



16

1. Uruchom Programmers Notepad (PN)
2. Wybierz File->NewProject
3. Utwórz nowy folder dla projektu
4. Utwórz nowy plik projektu
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WinAVR: Nowy projekt

WinAVR: Edycja pliku programu

Nie zapomnij zapisać zmienionych plików!



17

Schemat fragmentu
Zestawu ATMega 128

WinAVR: „Making” the project
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MegaLoad: Ładowanie programu

Pamiętaj by połączyć
Zestaw ATMega (RS1 connector)
z komputerem PC (COM1 or COM2)!

Wciśnij RESET
by załadować program

WinAVR � AVR Studio
AVR Studio jest środowiskiem programistycznym
(IDE) do uruchamiania i testowania napisanych
programów.
Aby załadować projekt utworzony
w WinAVR do AVR Studio należy:

1. Uruchomić AVR Studio (wer. 4.07 lub późniejsza),
2. Zamknąć okno Welcom to jeśli się pojawi,
3. Wybrać File->Open file…
   i załadować plik z rozszerzeniem cof,
4. Wybrać układ do symulacji:
   AVR Simulator i ATMega 128
5. Po załadowaniu projektu AVR Studio
   jest gotowe do pracy (debugowania)
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AVR Studio: Co należy wiedzieć

Znajdź w dokumentacji AVR Studio:

1. Do czego służą narzędzia: watch view,
register window, memory window i disassembler?

2. Jak uruchomić program, zatrzymać jego
wykonywanie i zresetować program?

3. Jaka jest różnica między trace into,
step over a step out?
                                  4. Co to jest pułapka (breakpoint)?

Metody reprezentacji
 danych w systemie binarnym
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System binarny

Byte (bajt) jest podstawową jednostką
pojemności pamięci komputerowej.
W przypadku nowoczesnych
komputerów przyjmuje się, że bajt
składa się z 8. bitów (8. cyfr w
systemie dwójkowym).

Word (słowo) jest określeniem ilości bitów, które w
sposób naturalny mogą być jedocześnie przetwarzane
przez określony system komputerowy. Liczba bitów
składających się na słowo zależy od architektury
określonego systemu komputerowego.

(Wikipedia)

Binarny system liczbowy przedstawia wartości liczb za pomocą dwóch
symboli (cyfr), zazwyczaj 0 i 1.

Zamiana na system dziesiętny:

1•32 + 0•16 + 0•8 + 1•4 + 1•2 + 0•1 =  38

Binarnie:         1001  1101  0110  0001  1110
Szesnastkowo:   9        D       6        1       E

Zamiana na system szesnastkowy:

System binarny
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Uzupełnij: Zamień liczby w systemie binarnym na
odpowiadające im liczby w systemach

dziesiętnym i szesnastkowym

110100100100
111111111111
000100000000
000000010000
000011111111

Zamień na system binarny:

Dziesiętnie: 128, 1276, 2048, 17
Szesnastkowo: 0xFF, 0x1111, 0x81

System binarny

Endianness - kolejność bajtów
W sytuacjach kiedy dane zapisywane są przy użyciu wielu (przynajmniej dwóch)
bajtów nie istnieje jeden określony sposób uporządkowania tych bajtów w pamięci
lub w czasie transmisji. Musi być użyta jedna z wielu konwencji ustalającej
kolejność bajtów (ang. "byte order" lub "endianness").  (Wikipedia)

Big-endian - najbardziej znaczący bajt
(MSB) danych zapisywany jest w
pamięci jako pierwszy (pod niższym
adresem). Następny bajt  według
znaczenia zapisywany jest pod
następnym adresem pamięci, itd.

Przykład:
00010111  01101100  = Dziesiętnie 5996

Adres Dana
n+2 ...
n+1 00010111
n 01101100
n-1 ...

Adres Dana
n+2 ...
n+1 01101100
n 00010111
n-1 ...

Little-endian - najmniej znaczący bajt
(LSB) danych zapisywany jest w
pamięci jako pierwszy (pod niższym
adresem).
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Liczby ze znakiem
Metoda uzupełnień do dwóch (U2)

Policzmy w dół (liczby 9. bitowe):

1 0000 0011 = dec. 259
1 0000 0010 = dec. 258
1 0000 0001 = dec. 257
1 0000 0000 = dec. 256
0 1111 1111 = dec. 255
0 1111 1110 = dec. 254
0 1111 1101 = dec. 253

Usuńmy 9.ty, najbardziej znaczący bit:

1 0 000 0011 = dec. 259 - 256 = 3
1 0 000 0010 = dec. 258 - 256 = 2
1 0 000 0001 = dec. 257 - 256 = 1
1 0 000 0000 = dec. 256 - 256 = 0
0 1 111 1111 = dec. 255 - 256 = -1
0 1 111 1110 = dec. 254 - 256 = -2
0 1 111 1101 = dec. 253 - 256 = -3

Znak

Uzupełnij:

Liczby ze znakiem
Metoda uzupełnień do dwóch (U2)
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Zmiana znaku w U2

Algorytm
1. Oblicz negację bitową wszystkich bitów (~)
2. Dodaj jeden (+1)

Przykład:

Dziesiętnie 12 00001100
Negacja bitowa 11110011
+1 11110100
Dziesiętnie -12

Negacja bitowa 00001011
+1 00001100
Dziesiętnie 12

System Binarny
Liczby stałoprzecinkowe

Liczba całkowita:

Dodajmy przecinek gdzieś
pomiędzy bitami:

Cz. całkowita Cz. ułamkowa

= Dziesiętnie 38

= Dziesiętnie 4 3/4

38 • 2-3 = 38 / 8 = 4 3/4
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System Binarny
Liczby zmiennoprzecinkowe

Liczba zmiennoprzecinkowa jest binarną reprezentacją liczby wymiernej,
używaną do reprezentowania przybliżonej wartości liczb rzeczywistych.
Liczba taka składa się z grup bitów mantysy (części ułamkowej), cechy
(wykładnika o podstawie 2) oraz bitu znaku.

Pojedyncza precyzja (32-bit) IEEE 754 Std.
:

Wartość    =   (–1)S 2E–127 (1.M)

Część
ułamkowa

Wartość E zamieniona jest tu na
dziesiętną bez znaku (dla 0 < E < 255)

Wyjątki:
S=0, E=255, M=0  +∞
S=1, E=255, M=0  -∞
E=255 NaN
S=0, E=0, M=0 0
E=0 denormalised no.= 

=(–1)S 2–126 (0.M)

System Binarny
Liczby zmiennoprzecinkowe
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Wartość =  (–1)S 2E–127 (1.M)

Przykład 1:
Zamień   1  10000010  110100000...0   na liczbę dzięsiętną

S = 1        E = 100000102 = 130         1.M = 1.11012 = 1 13/16
FP = (-1)1 2 130-127 1.11012 = -23 1.11012 = -1110.12  = -14 1/2

Przykład 2:
Zapisz  π  jako liczbę binarną, zmiennoprzecinkową

π = 3.14159265358979 = 3 + 0. 14159265358979 x 223  / 223 =
≈ 3 + 1187765 / 223 = 3 + 0.1001000011111101101012 =
= 11.1001000011111101101012 =
= 2 128-127 1.11001000011111101101012

0   10000000   11001000011111101101010

System Binarny
Liczby zmiennoprzecinkowe

Podwójna precyzja (64.bity) IEEE 754 Std. :

Wartość    =   (–1)S 2E–1023 (1.M)

System Binarny
Liczby zmiennoprzecinkowe
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System Binarny
Binary-coded decimals (BCD)

W BCD (SBCD 8421) każda cyfra
dziesiętna kodowana jest binarnym
kodem składającym się z 4. bitów.
Zazwyczaj bit po lewej ma wagę 8,
następny 4, 2, i 1. Jedynie
kombinacje bitów dające w wyniku
wartość od 0 do 9 są dopuszczalne.

(Wikipedia)

Przykład 1:

BCD 1001  0010  0101  0110

Dziesiętnie     9       3        5        6

Przykład 2:

BCD 1011  0010  1101  0110

Dziesiętnie Invalid   3   Invalid    6

System Binarny
Binary-coded decimals (BCD)
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System Binarny
Znaki alfanumeryczne i teksty

ASCII (American Standard Code for Information Interchange) jest liczbową reprezentacją
znaków alfanumerycznych (t.j.: 'a ', '5' lub ’#’) lub kodami sterującymi dla urządzeń drukujących
i wyświetlających tekst. ASCII opublikowano w 1963 (zdefiniowano kody dużych liter) i w 1967.

Przykład:

10001110   1101111   01101111   01100100   00001101   00001010

G                o               o                  d                 [CR]            [LF]

1100111   01110101   01111001   01110011   00000000
g                 u                   y                    s                   [NULL]

                      Koniec łańcucha tekstu w C

                        Przejście do nowej linii

System Binarny
Znaki alfanumeryczne i teksty
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ASCII (kod 7. bitowy) jest bardzo prosty i nie pozwala na
kodowanie znaków specyficznych dla języków innych niż
angielski. Istnieją rozszerzone “standardy ASCII” (kod 8. bitowy)
opracowane dla innych alfabetów, lecz są wzajemnie
niezgodne. Unicode (zazwyczaj kodowany 16. bitami) to
komputerowy zestaw znaków mający w zamierzeniu
obejmować wszystkie pisma używane na świecie.

Dodatkowe informacje:

•  http://www.lookuptables.com/

•  http://www.unicode.org/

System Binarny
Znaki alfanumeryczne i teksty

Obrazy cyfrowe
Obrazy Rastrowe

Dane obrazowe
FF FF FF FF 4F 4F 4F 4F FF FF FF FF FF FF FF FF

FF FF 31 FF FF 4F 4F FF FC FC FC FC FF FF FF FF

FF 30 35 35 37 37 FF FF FF BA BA FC FC FF FF FF

FF 30 35 35 37 37 37 FF FF FF BA BA FC FC FF FF

FF FF 35 35 35 37 37 37 FF FF FF BA BA FC FC FF

FF FF 31 35 35 35 37 37 37 37 FF BA BA BA FC FF

FF FF 30 35 35 35 35 37 37 37 37 FF BA BA FC FC

FF FF 4F 30 35 35 35 35 37 37 37 BA BA BA FC FC

FF FF 4F 30 30 35 35 35 35 37 37 BA BA BA FC FC

FF FF 4F 4F 30 30 35 35 4F 37 37 37 BA BA FC FC

FF FF FF 4F 4F 4F 30 30 4F FF 37 37 BA BA BA FC

FF FF FF 4F 4F 4F 4F 30 4F 4F FF FF BA BA FF FC

FF FF FF FF 4F 4F 4F 4F 4F 4F 4F FF BA BA FF FC

FF FF FF FF FF FF FF 4F 4F 4F 4F FF BA BA FF FF

FF FF FF FF FF FF FF 4F 4F 4F 4F FF FF FF FF FF

FF FF FF FF FF FF FF FF 4F 4F 4F 4F 4F FF FF FF

Paleta barw
40 00 40
40 60 00
40 40 80
00 40 40
A0 00 40
40 C0 00
40 40 E0

     ...
     ...
     ...

Nagłówek
42 4D 36 05 00 00 00 00 00 00 36 04 00 00 28 00
00 00 10 00 00 00 10 00 00 00 01 00 08 00 00 00
00 00 00 01 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 80 00 00 80
00 00 00 80 80 00 80 00 00 00 80 00 80 00 80 80

Piksel

Obrazy rastrowe to struktury danych binarnych reprezentujące sieć
prostokątną punktów obrazu (pikseli). Każdy z takich punktów ma
indywidualnie przypisaną daną określającą jego kolor lub poziom
jasności.
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SetPixelV(kontekst, x, y, RGB(r, g, b));
MoveToEx(kontekst, x, y, NULL);
LineTo(kontekst, x, y);
Rectangle(kontekst, x1, y1, x2, y2);

Obrazy wektorowe to dane opisujące obraz za pomocą
tzw. prymitywów czyli podstawowych kształtów, takich
jak punkty, linie, krzywe, wielokąty, itp. Kształt, kolor i
położenie każdego z prymitywów kodowane są za
pomocą kodów liczbowych.

Obrazy cyfrowe
Obrazy Wektorowe

Dźwięk

Próbkowanie i cyfryzacja dźwięku

....  10000010  11010000

....
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Programowanie układów
wejścia/wyjścia na przykładzie

laboratoryjnego systemu z
mikrokontrolerem ATMega128

Laboratoryjny System ATMega 128
Obsługa wyświetlacza

1. Schemat wewnętrzny portów ATMega 128,
2. Rejestry sterowania portami (PORTx, DDRx),
3. Funkcje wyprowadzeń sterownika wyświetlacza,
4. Konfiguracja sterownika z 4. i 8. bitową szyną danych,
5. Przesyłanie kodów konfigurujących sterownik LCD,
6. Wysyłanie znaków alfanumerycznych.

Wykład prowadzony jest z wykorzystaniem dokumentacji mikrokontrolera
ATMega 128 firmy ATMEL® oraz dokumentacji sterownika wyświetlacza
ciekłokrystalicznego (LCD) HD44780U firmy Hitachi®.

(ATMEL)

(Hitachi)
(P. Romaniuk, P. Skulimowski)
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Laboratoryjny System ATMega 128
Klawiatura 4x4

1. Schemat układu klawiatury,
2. Metody identyfikacji wciśniętego klawisza,
3. Schemat wewnętrzny portów ATMega 128,
4. Rejestry sterowania portami
    (PINx, SFIOR bit PUD).

Wykład prowadzony jest z wykorzystaniem
dokumentacji mikrokontrolera
ATMega 128 firmy ATMEL®.

1 1 0 1

1

1

1

1

1 1 0 1

1

1

1

1

1 1 0 1

1

0

1

1

1

1

1

1

(ATMEL)

Architektura systemu
komputerowego
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Architektura systemu komputerowego
Sygnał żądania przerwania
Sygnały DMA (bezpośredniego dostępu do pamięci)
Sygnały zapisu i odczytu
Magistrala adresowa
Magistrala danych
Sygnał wyboru 
układu scalonego Mikroprocesor (CPU) Oscylator

RAM

ROM

DMARejestryPrzerwania

Urządzenia We./Wy.

Dekoder
Adresu

Mikroprocesor (CPU) Oscylator

RAM

ROM

DMARejestryPrzerwania

Ukłądy We./Wy.

Dekoder
Adresu

Magistrala adresowa służy do przesyłania adresu czyli wartości binarnej
określającej gdzie ma zostać zapisana dana lub skąd ma zostać pobrana dana.
Magistrala danych służy do przesyłania danej, wartości binarnej w czasie zapisu lub
odczytu.
Magistrala sterująca jest wykorzystywana w systemie komputerowym do
komunikacji pomiędzy układami tego systemu.

Przesłanie danej (np. instrukcji programu) pomiędzy pamięcią a mikroprocesorem
wymaga podania przez procesor miejsca w pamięci (magistrala adresowa) gdzie
znajduje się dana, wysłania do pamięci sygnału żądania odczytu (magistrala
sterująca) i odczytu wartości danej poprzez magistralę danych.

Magistrala lub szyna w systemie
komputerowym to system połączeń służący
do przesyłania danych lub zasilania pomiędzy
układami wewnetrznymi komputera.
Magistrala (np. danych lub adresowa) to
grupy równoległych połączeń (przewodów)
łączących podzespoły systemu
komputerowego, z których każdy służy do
przesyłania sygnału logicznego.

Gdzie

Co

Jak

Architektura systemu komputerowego
Magistrala danych, adresowa i sterująca
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Architektura von Neumanna oznacza taki system komputerowy, w którym
zarówno program wykonywany przez system jak i dane przetwarzane
przez ten system zapisane są w tym samym urządzeniu do składowania
danych. Określenie architektura von Neumanna używane jest też w
znaczeniu rozdzielenia układów odpowiedzialnych za składowanie
danych i za ich przetwarzanie.

Architektura Harwardzka oznacza taki system komputerowy w którym
stosowane są oddzielne urządzenia do przechowywania insturkcji
programu i oddzielne dla przetwarzanych danych. Określenie to pochodzi
od komputera przekaźnikowego Harvard Mark I, w którym instrukcje
programu zapisane były na taśmie perforowanej a dane w pamięci
wykorzystującej przekaźniki.

Architektura systemu komputerowego

Oddzielne sygnały 
odczytu pamięci 

programu i danych

Oddzielne
urządzenia do

składowania danych
i do przechowywania
instrukcji programu

Architektura
Harwardzka

Architektura systemu komputerowego
Przykład: Intel 8051
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Architektura
von Neumanna

Dekoder 
adresu

64 KB 64 KB
32 KB

32 KB

Architektura systemu komputerowego
Przykład: Intel 8051

Mikroprocesor (CPU - Central Processing
Unit) to część systemu komputerowego,
która odczytuje, interpretuje i wykonuje
instrukcje.

Motorola 6800 (H. Feichtinger, Mikrokomputery – poradnik)

Architektura systemu komputerowego
Mikroprocesor (CPU)

Mikroprocesor (CPU) Oscylator

RAM

ROM

DMARejestryPrzerwania

Układy We./Wy.

Dekoder
Adresu



35

Mikroprocesor (CPU) Oscylator

RAM

ROM

DMARejestryPrzerwania

Układy We./Wy.

Dekoder
Adresu

Architektura systemu komputerowego
Pamięć

Pamięci półprzewodnikowe

RAM
Random-access Memory

ROM
Read-only Memory EPROM

Erasable 
Programmable 

ROM
SRAM
Static NVRAM 

Non-volatile

DRAM
Dynamic

EEPROM
Electrically 

Erasable ROM

PROM
Programmable 

ROM

EAROM
Electrically 

Alterable ROMFIFO

SDRAM

Rambus

DDR

TTL                       MOS
Komórka pamięci statycznej

Komórka pamięci dynamicznej

Pamięć statyczna RAM
zachowuje swoją zawartość
tak długo jak dołączone jest
do niej zasilania.
- Szybki dostęp,
- Małe pojemności.

Pamięć dynamiczna RAM
wymaga odświerzania.
- Wydłużony czas dostępu,
- Duże pojemności.

Architektura systemu komputerowego
Pamięć statyczna i dynamiczna RAM
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Pamięć FIFO (First In, First Out -
pierwszy wchodzi, pierwszy
wychodzi) jest pamięcią, w której
dane organizowane są w formie
kolejki. Dane muszą być odczytane
z pamięci w tej samej kolejności w
jakiej zostały do tej pamięci
wpisane. Pamięci FIFO
wykorzystywane są w układach do
buforowanie danych.

Pamięć LIFO (Last In, First Out -
ostatni wchodzi, pierwszy
wychodzi) MSM518221A (OKI Semiconductors)

Architektura systemu komputerowego
FIFO

Architektura systemu komputerowego
Dynamiczne RAM: SDRAM, DDR RAM

Synchronous Dynamic (SD) RAM (Dynamiczna pamięć synchroniczna RAM) jest
udoskonaloną pamięcią typu DRAM. Dostęp do pamięci DRAM jest
asynchroniczny. Pamięć DRAM natychmiast reaguje na sygnały odczytu. SDRAM
jest pamięcią synchroniczną, która odpowiada na sygnały odczytu lub zapisu
dopiero po pojawieniu się odpowiedniego sygnału taktującego (zegarowego).
Sygnał zegarowy steruje wewnętrzny układ kolejkujący żądania odczytu lub
zapisu danych.
Double data rate (DDR) SDRAM jest nowszym opracowaniem pamięci
synchronicznych SDRAM. Pamięci te wykorzystywane są w komputerach PC od
roku 2000. W pamięciach tych również wykorzystywany jest sygnał zegarowy. O
ile jednak zwykłe pamięci SDRAM reagują na opadające zbocze sygnału
zegarowego o tyle pamięci DDR SDRAM wykorzystują oba zbocza, narastające
jak i opadające.
Pamięci Direct Rambus DRAM (DRDRAM), czasami określane również jako
RDRAM, działają w podobny sposób jak DDR SDRAM, wykorzystują jednak
specyficzną metodę sterowania opracowaną przez firmę Rambus, umożliwiającą
zastosowanie sygnałów zegarowych o większej częstotliwości.
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Architektura systemu komputerowego
PROM, EPROM, EEPROM

PROMs (Programmable Read-Only Memory) są pamięciami ROM, które mogą być
programowne jednorazowo za pomocą specjalnego urządzenia, programatora. Proces
programowania polega na trwałym przepaleniu wewnętrznych połączeń wewnątrz układu
scalonego pamięci.
EPROMs (Erasable Programmable
Read-Only Memory) są pamięciami,
w których jako komórkę pamięci
wykorzystuje się tranzystor MESFET
z tzw. bramką pływającą (floating gate).
Poziom logiczny zapisywany jest za
pomocą ładunku zgromadzonego na     MESFET z pływającą bramką
bramce pływającej. Pamięć może być
kasowana promieniowaniem ultrafioletowym, a następnie ponownie programowna.
EAROMs (Electrically Alterable Read-Only Memory), w pamięci tej elektrycznie mogą być
modyfikowane poszczególne bity zapisanej w nich informacji. Jednak proces modyfikowania
danych powinien być przeprowadzany stosunkowo rzadko.

EEPROM np. Flash memory (Electrically Erasable Read-Only Memory) to pamięć, w której zapis
danych przeprowadzany jest podobnie jak w EPROM. Cała pamięć (lub jej bloki) może zostać
skasowana elktrycznie.

PN N

Mikroprocesor (CPU) Oscylator

RAM

ROM

DMARejestryPrzerwania

Układy Wejścia/Wyjścia

Dekoder
adresu

Układy wejścia/wyjścia (I/O devices) to te
układy systemu komputerowego, które
umożliwiają komunikację systemu z
człowiekiem (np. za pomocą monitora,
klawiatury czy myszy) lub innym systemem
komputerowym (np. za pomocą karty
sieciowej czy modemu).
W architekturze systemu komputerowego
mikroprocesor oraz pamięć traktowane są
jako serce komputera. Pozostałe układy
systemu komputerowego traktowane są
jako urządzenie wejścia/wyjścia.

Metody komunikacji z układami wejścia/wyjścia:
•Rejestry urządzeń wejścia/wyjścia

•Memory-mapped I/O (MMIO) - rejestry w przestrzeni adresowej pamięci
•Port-mapped I/O (PMIO) - rejestry w specjalnej przestrzeni tzw. portów

•Direct memory access (DMA) - bezpośredni dostę do pamięci
•Interrupts - system przerwań

Architektura systemu komputerowego
Układy wejścia/wyjścia
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MMIO - część przestrzeni adresowej
pamięci zostaje wydzielona na
potrzeby rejestrów urządzeń we/wy.
Do zapisu/odczytu danych do/z
rejestrów wykorzystywane są te same
szyny i te same rozkazy procesora co
w przypadku pamięci.

PMIO - przestrzeń adresowa rejestrów urządzeń we/wy (portów) i pamięci są
rozdzielone. Oddzielne są sygnały zapisu/odczytu danych (szyna sterująca) w
przypadku pamięci i rejestrów. Czasami rozdzielone są również szyny adresowa i
danych. Inne są też rozkazy procesora dotyczące przesyłania danych między
procesorem a pamięcia i inne dla przesyłania danych między procesorem a
rejestrami urządzeń we/wy.

Mikroprocesor (CPU) Oscylator

RAM

ROM

DMARejestryPrzerwania

Układy Wejścia/Wyjścia

Dekoder
adresu

Architektura systemu komputerowego
Układy wejścia/wyjścia: Rejestry

Direct memory access (DMA) -
bezpośredni dostęp do pamięci to
technika przesyłania danych w systemie
komputerowym, w której pewne
urządzenia wejścia/wyjścia zapisują dane
do pamięci lub odczytują dane z pamięci
bez pośrednictwa mikroprocesora.

Sygnały sterujące DMA:
•żądanie dostępu do pamięci
•zezwolenie na dostęp do pamięci

Architektura systemu komputerowego
Układy wejścia/wyjścia: DMA

Mikroprocesor (CPU) Oscylator

RAM

ROM

DMARejestryPrzerwania

Układy Wejścia/Wyjścia

Dekoder
adresu
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Sterownik DMA

Sterownik DMA w konfiguracji
kaskadowej (Master-Slave)

Intel 8086

Przykład: DMA w IBM PCMikroprocesor (CPU) Oscylator

RAM

ROM

DMARejestryPrzerwania

Układy Wejścia/Wyjścia

Dekoder
adresu

Architektura systemu komputerowego
Układy wejścia/wyjścia: DMA

Procesory mają zazwyczaj programowy mechanizm umożliwiający zablokowanie reagowania
na żądanie przerwania (np. poprzez odpowiednie wpisy do rejestrów urządzenia generującego
przerwanie lub rejestrów wewnętrznych samego procesora, poprzez które blokowane są
przerwania). Przerwania, które mogą być blokowane nazywa się maskowalnymi.  Przerwania,
których nie można wyłączyć programowo nazywają się niemaskowalnymi.

Przerwania: systemy komputerowe
zazwyczaj pozwalają na niezwłoczne
wykonanie określonych fragmentów
programu w wyniku zaistnienia zdarzenia
związanego z działaniem układów
wejścia/wyjścia. Zdarzenie takie
sygnalizowane jest mikroprocesorowi przez
urządzenie we./wy. poprzez sygnał żądania
przerwania (interrupt requests IRQ).
Procesor zawiesza wówczas wykonywanie
aktualnie realizowanego programu i
wykonuje inny fragment programu, tzw.
procedurę obsługi przerwania.

Architektura systemu komputerowego
Układy wejścia/wyjścia: Przerwania

Mikroprocesor (CPU) Oscylator

RAM

ROM

DMARejestryPrzerwania

Układy Wejścia/Wyjścia

Dekoder
adresu
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Sterownik przerwań

Intel 8086

Sterownik przerwań w konfiguracji
kaskadowej (Master-Slave)

Architektura systemu komputerowego
Układy wejścia/wyjścia: Przerwania

CPU Oscylator

RAM

ROM

DMARejestryPrzerwania

Układy Wejścia/Wyjścia

Dekoder
adresu

Przykład: System przerwań w IBM PC

Pamięci ATMega 128
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ATMega 128
Pamięci

1. Pamięć Programu typu Flash,
2. Pamięć danych typu SDRAM,
3. Pamięć danych typu EEPROM,
4. Dołączanie zewnętrznej
    pamięci danych.

(ATMEL)

128KB = 16 x 64K

(ATMEL)

EEPROM
4KB

Jaka to architektura:
 von Neumanna czy Harwardzka?

Jaki jest sposób mapowania
rejestrów we/wy: PMIO czy MMIO?

Wykład prowadzony jest z wykorzystaniem
dokumentacji mikrokontrolera ATMega 128
firmy ATMEL®.

(ATMEL)(ATMEL)
(ATMEL)

ATMega 128
Pamięci

Wykład prowadzony jest z wykorzystaniem
dokumentacji mikrokontrolera ATMega 128
firmy ATMEL®.

1. Pamięć Programu typu Flash,
2. Pamięć danych typu SDRAM,
3. Pamięć danych typu EEPROM,
4. Dołączanie zewnętrznej
    pamięci danych.
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System przerwań ATMega 128

ATMega 128
System przerwań

1. Tablica wektorów przerwań,
2. Położenie tablicy,
3. Programownie obsługi przerwań.

(ATMEL)

Wykład prowadzony jest z wykorzystaniem
dokumentacji mikrokontrolera ATMega 128
firmy ATMEL®.

Zmienne
globalne

Procedura
przerwania

Konfigurowanie 
urządzenia we./wy. 

wysyłajacego 
żądanie przerwania



43

Jednostka centralna ATMega 128

ATMega 128
Jednostka centralna - procesor

1. Jednostka arytmetyczno-logiczna,
2. Rejestry ogólnego przeznaczenia,
3. Rejestry indeksujące,
4. Rejestr (Flagowy) Statusowy,
5. Stos i wskaźnik stosu,
6. Instruction Execution Timings.

(ATMEL)

(ATMEL)

(ATMEL)

Wykład prowadzony jest z wykorzystaniem
dokumentacji mikrokontrolera ATMega 128
firmy ATMEL®.
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Procesory

Procesory
RISC, CISC, VLIW...

Complex Instruction Set Computer (CISC) - komputer o złożonej liście
instrukcji to taki, w którym każda z instrukcji wymaga od procsora wykonania
sekwencji kilku operacji niższego poziomu, np. odczytu danej z pamięci,
operacji arytmetycznej, zapisu danej wynikowej. Cechami CISC są:

•Czas wykonania instrukcji jest różny i zależy od jej złożoności,
•Kody instrukcji mają różną długość w bitach,
•Program składa się ze stosunkowo niewielkiej liczby instrukcji.

Reduced Instruction Set Computer (RISC) - komputer o ograniczonej liście
innstrukcji to taki, w którym lista instrukcji procesora jest stosunkowo
niewielka. W większości instrukcje powodują wykonanie stosunkowo prostej
operacji. Procesor jest tak zaprojektowany by każda instrukcja została
wykonana w jak najkrótszym czasie. Cechami RISC są:

•Większość instrukcji wykonywana jest w jednym cyklu zegarowym,
•Kody większości instrukcji mają równą długość w bitach,
•Program składa się zazwyczaj ze znacznej liczby instrukcji.
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Procesory
RISC, CISC, VLIW...

Very Long Instruction Word (VLIW) - bardzo długie słowo instrukcji to
określenie charakteryzujące mikroprocesory, których pojedyncze instrukcje
wymagają wykonania kilku prostych operacji, przy czym operacje te
wykonywane są równolegle (w tym samym czasie). is a design of a
microprocessor that packs many simple RISC-like instructions into a much
longer internal instruction word format.

Explicitely Parallel Instruction Computing (EPIC) to określenie wprowadzone
przez fimę Intel równoważne VLIW.

Instruction pipeline - przetwarzanie potokowe instrukcji to technologia
wykorzystywana do zwiększenia efektywności działania mikroprocesora.
Przetwarzanie potokowe zwiększa szybkość wykonania programu choć
wprowadza niewielkie opóźnienia w wykonywaniu poszczególnych instrukcji.

Wykonanie pojedynczej instrukcji wymaga zazwyczaj kilku kroków
obsługiwanych często przez niezależne moduły mikroprocesora. System bez
przetwarzania potokowego wykonuje jedną instrukcję w czasie i dopiero po
jej kompletnym wykonaniu przechodzi do wykonywania następnej. W
systemie z przetwarzaniem potokowym wykonywanie następnej instrukcji
rozpoczyna się w czasie wykonywania kolejnych kroków instrukcji
poprzedniej.

Procesory
Pipeline - potokowość
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Procesory
Pipeline - potokowość

Instrukcja 3
Instrukcja 4

Instrukcja 6

odczyt kodu 
instrukcji z pamięci

odczyt argumentu
 instrukcji 

wykonanie
instrukcji 

zapis wyniku
do pamięci

Instrukcja 5

Instrukcja 1
Instrukcja 2

Z przetwarzaniem potokowym

odczyt kodu 
instrukcji z pamięci

odczyt argumentu
 instrukcji 

wykonanie
instrukcji 

zapis wyniku
do pamięci

Instrukcja 2 Instrukcja 1Instrukcja 3

Bez przetwarzania potokowego

Instrukcja 7

Określenie skalarny oznacza procesor, który
wykonuje jedną instrukcje w pojedynczym cyklu
zegarowym w przeciwieństwie do systemów,
które do wykonania instrukcji wymagają kilku
takich cykli.
Procesor superskalarny to taki, w którym
zaprojektowano mechanizm wykonywania kilku
instrukcji równolegle w jednym cyklu zegarowym.

Procesory
Skalarny i superskalarny
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Single Instruction, Multiple Data (SIMD) - jedna instrukcja, wiele
danych - to określenie jest związane z systemami komputerowymi, w
których pojedyncze instrukcje powodują przetworzenie zbioru różnych
danych (wektora danych lub macierzy danych) w sposób równoległy
(w tym samym czasie). Mikroprocesor, który umożliwia takie
przetwarzanie danych nazywany jest zazwyczaj wektorowym lub
macierzowym (vector processor, array processor).

Przykład: technologia SIMD w Intel Pentium II i III:

•Multi-Media eXtensions (MMX) to dodatkowy zbiór instrukcji
umożliwiających równoległe przetwarzanie danych całkowitych,
szczególnie przydatne w zastosowaniach multimedialnych.

•Streaming SIMD Extensions (SSE) to zbiór instrukcji
umożliwiających  równoległe przetwarzanie danych
zmiennoprzecinkowych pojedynczej precyzji.

Procesory
SIMD

Programowanie w asemblerze
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Asembler
Opkod i Mnemonik

System kodów (binarnych) bezpośrednio zrozumiałym dla
mikroprocesora, wykonywanym przez procesor, jest nazywany kodem
maszynowym mikroprocesora.

Opkod (opcode = operation code) to część kodu maszynowego
instrukcji określająca jaka operacja ma być wykonana przez
mikroprocesor.

Język asemblera (assembly) to symboliczny zapis odpowiadający
kodowi maszynowemu, który jest bardziej zrozumiały dla człowieka.
Kod maszynowy (kodu binarne zero-jedynkowe) staje się bardziej
zrozumiały po zamianie na nazwy literowe nazywane mneminikami.

Mnemonik (mneminic) to kod literowy składający się zazwyczaj z 2 do
5 liter, który reprezentuje opkod. Za mnemonikiem znajduje się
zazwyczaj odpowiednia lista argumentów, operandów instrukcji.

(Borland C++ Builder CPU window)

(AVRStudio disassembler window)

AVR ATMega 128

Intel Pentium Processor

CISC czy RISC?

Address Opcode   Mnemonic Argument(s)

Asembler
Opkod i Mnemonik
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Asembler w języku polskim używany jest w dwóch
znaczeniach, jako język programowania niskiego poziomu
(ang. assembly) oraz jako program tłumaczący ten język na
kod maszynowy - kompilator tego języka (ang. assembler).
Każdy rodzaj mikroprocesora ma swój własny, specyficzny kod maszynowy.
Różnią się one rodzajem instrukcji, operacji jakie mogą być wykonane, rejestrami,
typami danych, itp. Stąd, również języki asemblera są specyficzne dla różnych
typów mikroprocesorów.

Tłumaczenie asemblera języka wykonywane jest przez asembler kompilator. Przy
czym instrukcja kodu maszynowego jednoznacznie odpowiada jednej instrukcji
asemblera (mnemonikowi). Dlatego w przypadku asemblera możliwe jest
tłumaczenie w drugą stronę, kodu maszynowego na język asemblera. Proces ten
nazywany jest disasemblacją.

Kompilator asemblera jednego typu mikroprocesora uruchamiany w systemie
komputerowym z innym typem mikroprocesora nazywany jest krosasemblerem
(crossassembler).

Asembler
Język i Kompilator

•Działania artymetyczne i logiczne
•Rozgałęziania programu (skoki)
•Przesyłanie danych
•Działania na bitach
•Instrukcje sterujące

(ATMEL)

Asembler
Grupy instrukcji
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(ATMEL)

•Działania artymetyczne i logiczne
•Rozgałęziania programu (skoki)
•Przesyłanie danych
•Działania na bitach
•Instrukcje sterujące

Asembler
Grupy instrukcji

•Działania artymetyczne i logiczne
•Rozgałęziania programu (skoki)
•Przesyłanie danych
•Działania na bitach
•Instrukcje sterujące

(ATMEL)

Asembler
Grupy instrukcji
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•Działania artymetyczne i logiczne
•Rozgałęziania programu (skoki)
•Przesyłanie danych
•Działania na bitach
•Instrukcje sterujące

(ATMEL)

Asembler
Grupy instrukcji

•Działania artymetyczne i logiczne
•Rozgałęziania programu (skoki)
•Przesyłanie danych
•Działania na bitach
•Instrukcje sterujące

(ATMEL)

Asembler
Grupy instrukcji
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Tryby adresowania to określenie związane ze sposobem pobierania i
zapisywania danych (operandów) niezbędnych do wykonania instrukcji kodu
maszynowego. Tryby adresowania określają sposób obliczania adresu
danej w pamięci lub przestrzeni rejestrów urządzeń wejścia/wyjścia lub
określenia rejestru wewnętrznego mikroprocesora, który tę daną zawiera.

Przykłady trybów adresowania:
Natychmiastowy - wartość operandu podana w kodzie maszynowym instrukcji
Bezpośredni - w kodzie podany jest adres operandu w pamięci
Pośredni - adres operandu znajduje się w pamięci pod podanym adresem
Rejestrowy - operand znajduje się w rejestrze wewnętrznym procesora
Rejestrowy pośredni - adres operandu znajduje się w rejestrze procesora
Indeksowy bezpośredni - adres operandu jest sumą zawartości rejestru i wartości
podanej w kodzie
Autoinkrementowany - jak wyżej z tym, że zawartość tego rejestru jest zwiększona
o jeden po wykonaniu instrukcji
Bazowy - adres danej jest sumą zawartości rejestru i wartości podanej w kodzie
Absolutny - w kodzie podany jest adres w pamięci programu
Względny - w kodzie podane jest przesunięcie względem adresu instrukcji

Jakie są tryby adresowania ATMega 128?

Asembler
Tryby adresowania

(AVRStudio Tools User Guide)

Linia kodu źródłowego asemblera:
[etykieta:] dyrektywa [operand(y)] [Komentarz]
[etykieta:] mnemonik [operand(y)] [Komentarz]
Komentarz
Pusta linia

etykieta:

przy czym komentarz to tekst rozpoczynający się od średnika:
; [Tekst]

Asembler
Format linii kodu w asemblerze ATMega 128



53

Etykieta to identyfikator złożony z liter i cyfr rozpoczynający się od litery.
Zazwyczaj etykieta określa konkretne miejsce w pamięci czyli adres.
procedura: sts portb, r17

dec r17

Stała w programie definiowana jest za pomocą dyrektywy EQU. Wartości
stałych nie mogą być zmieniana w czasie wykonywania programu.
.EQU tab_size = 4
.EQU porta = 0x25

Zmienna definiowana jest z wykorzystaniem etykiety. Etykieta wskazuje
miejsce w pamięci danych a wartość znajdująca się w tym miejscu może być
modyfikowana w czasie wykonywania programu.
var1: .BYTE 1
table: .BYTE tab_size

Asembler
Etykieta, stała, zmienna w asemblerze ATMega 128

; main program
...
rcall procedure_name
...

procedure_name:
...
; procedure body here
call other_procedure_name
...
ret

other_procedure_name:
...
; procedure body here
...
ret

Co to jest stos? Jak instrukcje call i ret wykorzystują stos?

Asembler
Procedury w asemblerze ATMega 128
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.MACRO SUBI16 ; Start macro definition
subi @1,low(@0) ; Subtract low byte
sbci @2,high(@0) ; Subtract high byte

.ENDMACRO ; End macro definition

.CSEG ; Start code segment
SUBI16 0x1234,r16,r17 ; Sub.0x1234 from r17:r16

(AVRStudio Tools User Guide)

Asembler
Makrodefinicja w asemblerze ATMega 128

Procedura:
- wolniej działa

potrzebny jest dodatkowy czas na skoki będące wynikiem instrukcji
call i ret

- mniejszy kod programu
procedura znajduje się tylko w jednym określonym miejscu kodu
programu

Makrodefinicja:
- szybciej działa

kod jest wklejony w całości tam gdzie jest potrzebny, brak
dodatkowych skoków

- większy kod programu
kod makrodefinicji jest powielany

Asembler
Procedura a makrodefinicja
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Dyrektywy wykorzystywane są
do sterowania procesem
kompilacji asemblera na kod
maszynowy. Dyrektywy nie są
tłumaczone przez na kod
maszynowy. Są one między
innymi wykorzystywane do
określania położenia programu
w pamięci, definiowania
makrodefinicji, inicjalizacji
pamięci, itp.

(AVRStudio Tools User Guide)

Dyrektywa Opis
BYTE Reserve byte to a variable
CSEG Code Segment
CSEGSIZEProgram memory size
DB Define constant byte(s)
DEF Define a symbolic name on a register
DEVICE Define which device to assemble for
DSEG Data Segment
DW Define Constant word(s)
ENDM End macro
EQU Set a symbol equal to an expression
ESEG EEPROM Segment
EXIT Exit from file
INCLUDE Read source from another file
LIST Turn listfile generation on
LISTMAC Turn Macro expansion in list file on
MACRO Begin macro
NOLIST Turn listfile generation off
ORG Set program origin
SET Set a symbol to an expression

Asembler
Dyrektywy

(AVRStudio Tools User Guide)

Wyrażenia w asemblerze mogą
zawierać operandy, operatory i
funkcje. Wyrażenia te
wykorzystywane są w procesie
kompilacji i nie są tłlumaczone na
kod maszynowy

Operatory
 Symbol Opis

! Logical Not
~ Bitwise Not
- Unary Minus
* Multiplication
/ Division
+ Addition
- Subtraction
<< Shift left
>> Shift right
< Less than
<= Less than or equal
> Greater than
>= Greater than or equal
== Equal
!= Not equal
& Bitwise And
^ Bitwise Xor
| Bitwise Or
&& Logical And
|| Logical Or

Funkcje
LOW(expression) returns the low byte of an expression 
HIGH(expression) returns the second byte of an expression 
BYTE2(expression) is the same function as HIGH 
BYTE3(expression) returns the third byte of an expression 
BYTE4(expression) returns the fourth byte of an expression 
LWRD(expression) returns bits 0-15 of an expression 
HWRD(expression) returns bits 16-31 of an expression 
PAGE(expression) returns bits 16-21 of an expression 
EXP2(expression) returns 2 to the power of expression 
LOG2(expression) returns the integer part of log2(expression) 

Czy operator ‘+’ jest zamieniany przez asembler na instrukcję add?

Asembler
Wyrażenia
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1. Uruchom AVR Studio
2. Wybierz Project->NewProject
3. Zaznacz Create initial File oraz Create Folder
4. Wypełnij pola Project Name i Initial File
5. Wciśnij Finish
6. Napisz program w asemblerze
7. Skompiluj projekt do kodu maszynowego

Asembler
Projekt asemblerowy w AVR Studio

Przykład:

Asembler
Projekt asemblerowy w AVR Studio

1. Uruchom AVR Studio
2. Wybierz Project->NewProject
3. Zaznacz Create initial File oraz Create Folder
4. Wypełnij pola Project Name i Initial File
5. Wciśnij Finish
6. Napisz program w asemblerze
7. Skompiluj projekt do kodu maszynowego
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W języku C słowo asm umożliwia dołączenie pojedynczych linii w języku
asemblera w kodzie źródłowym w języku C.

W kompilatorze GCC robi się to tak:
asm(”mnemonik [operand(y)]");

Przykład:

Asembler
Łączenie asemblera z C w WinAvr

W projekcie WinAvr w kodach źródłowych języka C można
wykorzystywać całe procedury napisane w asemblerze. Kody
źródłowe języka C oraz asemblera muszą być umieszczone w
osobnych plikach (z rozszerzeniem c i asm).

1. Utwórz nowy plik źródłowy z rozszerzeniem asm i dodaj go do projektu,
2. Dodany plik poddaj edycji, zdefiniuj w nim procedurę w asemblerze,
    która ma być wywoływana z kodu w języku C,
3. Dodaj utworzony plik do listy plików asemblerowych w pliku Makefile
4. Zadeklaruj odpowiednio napisaną procedurę w kodzie źródłowym języka C,
5. Uzupełnij kod w C o wywołanie procedury asemblerowej

Asembler
Łączenie asemblera z C w WinAvr
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Przykład:

Asembler
Łączenie asemblera z C w WinAvr

1

2

3

4

5

Przetwornik
Analogowo-Cyfrowy

ATMega 128



59

(Piotr Skulimowski, Piotr Romaniuk)

ATMega 128
 ADC

1. Połączenie wejścia analogowego w zestawie laboratoryjnym,
2. Częstotliwość zegara układu ma wpływ na pracę przetwornika,
3. Charakterystyki przetwornika analogowo-cyfrowego,
4. Kanały analogowe i wybór wzmocnienia,
7. Wybór napięcia odniesienia (referencyjnego),
5. Tryby pojedynczej konwersji i swobodnego przetwarzania,
6. Preskaler a czas i dokładność przetwarzania,
7. Odczyt wyniku działania przetwornika,
8. Rejestry przetwornia: ADMUX, ADCSRA, ADC

Wykład prowadzony jest z wykorzystaniem
dokumentacji mikrokontrolera ATMega 128
firmy ATMEL®.

(ATMEL)

(ATMEL)
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Wykład prowadzony jest z wykorzystaniem
dokumentacji mikrokontrolera ATMega 128
firmy ATMEL®.
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ATMega 128
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(ATMEL)

(ATMEL)


